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Introduction 
MyPima is a secure site providing Pima students, faculty and staff with online services 
and information. Students use MyPima to check e-mail, register for courses, and log into 
WebCT for online classes. Employees access to Banner Online services and Banner 
forms, Pima Reports, and more through MyPima. 
 
MyPima automatically generates a course home page for each credit course CRN. These 
course homepages give faculty other communication channels with students in their 
classes. Besides posting documents, faculty can send out announcements and news plus, 
create a message board and send/receive email. Students registered for your class will 
automatically have access to the course homepage making it easy for them to find class 
information. 
 
For WebCT courses, faculty will have access to a red “edit” button on the My Courses 
page that will allow them to switch student access to the WebCT homepage.  If you 
should be using WebCT and do not have an edit button next to the course title on the My 
Courses page, ask your campus scheduler to put the WEBCT code into Banner for your 
class.  The change may not be picked up by MyPima until the next day. 
 
MyPima is customized to the specific roles individuals have a Pima: students vs 
employees. Depending on your role(s), you will have the ability to view, create and 
manage different sections of MyPima and the course website. 
 
The process of using the Course Homepage is really quite simple: 
 

1. Login to MyPima. 
2. Configure the Course Homepage. 

a. Enable applications. 
b. If necessary, set/review members and permissions. 

3. Add content using the Content Tools. 
4. Manage the Course Homepage during the semester. 
 

Keep these five steps in mind as you go through this tutorial.  
 
As of July 23, 2007, each CRN or Consolidated course in MyPima can contain a total of 
500 MB of content. 
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Learning Outcomes 
This workshop will focus on the fundamentals of using Course Home page. When you 
complete this workshop, you will be able to 
 

• Log on to MyPima. 
• Understand the purposes of the Course Tools (The Homepage, Announcements, 

News, Photos, Links, Files, Message Board, Calendar, Email, Chat and 
Members.) 

• Navigate using the breadcumbs. 
• Manage the Course using the Content Tools. (The Homepage, Announcements, 

News, Photos, Links, Files, Message Board, Calendar, Email, Chat and 
Members.) 

• Configure the Course Homepage using the Configuration Tools. (Applications,  
Permissions.) 

• Know the differences between the student and course leader view. 
• Use contextual help. 
• Use the Course Homepage in the classroom. 
• Log out of MyPima. 

 
Materials needed:  

• This document. 
• A working computer with internet access. 
• A username and password for MyPima. 
• Pen or pencil and paper for notes. 
• Optional: Any course material you want to post online, such as a syllabus. 

 
Intended Audience: Facility and staff members who have no prior experience with using 
the Course Homepage. 
 
Prerequisites: None. 
 
Course format: Lecture with hands-on practice.  
 
Workshop duration: Two hours. 
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Getting Started 
You will need a MyPima username 
and password before you can log into 
the MyPima production system or 
training server. To set up your 
MyPima account, use the self-
discovery tool (“Activate My 
Account”) available on the MyPima 
login page. 
 
All faculty should be able to log into 
the training server to try out the My 
Courses tools.  Go to: 
http://mypimatraining.pima.edu  and 
log in using your real MyPima 
username and password.  Note that 
this server is designed for My Courses training:  some other channels and links do not 
work;  it is available from on- or off-campus;  and announcements or email created on 
this server will not be sent to actual students or faculty.  
 
When you log in, you will see an interface similar to what you see below. The layout has 
4 sections: My Account and Content/Layout links, Tabs, Utility Icons and various 
Channels.  
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My Account and the Content/Layout Tools 
These two hyperlinks, located in the upper left-hand corner, let you change your 
password and individualize the content and layout of your portal homepage. 
 
Change Password 
You may change your password from the MyPima login page or from within MyPima.    
 
The Content/Layout Tools 
The Content/Layout Tools lets you customize the look of your MyPima webpage. Using 
this tool, you can add or modify tabs, channels and columns. This workshop does not 
specifically address these tools, but there are clear instructions on how to use these tools 
on the Content/Layout Tools page. You may not delete a tab.   
 
Some of the layout tabs, channels and columns will be part of the default layout and 
cannot be deleted or removed.  
 

Channels  
Channels provide information or online services to you. You may add or delete channels 
using the Content/Layout link. Channels are created and deployed by the Web Systems 
Office. As we move forward, more channels will be available to you. You will be alerted 
to new channels through the MyPima Update channel on the Home tab. 

Tabs 
• Each tab allows you to go to a set of customizable channels. The Home tab can 

not be removed, and everyone has the same default channels on this tab. These 
channels will change as we complete development of the portal. You may also 
add channels to his tab by 

 

Utility Icons 
These icons, in the upper right-hand corner, provide links to other MyPima features and 
applications: 
 

• Email provides easy access to the student e-mail application, which allows 
students to send and receive email messages. 

• Calendar is an application allowing students and employees access to course, 
group and personal calendars. 

• Groups provide a group homepage and communication tools for clubs, 
committees, departments and other college-related activities.  

 
Student email/calendar: The student email and calendar system is different then the one 
used for employee email. Students will use MyPima to access their email. It is a fully-
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functioning email system that can send/receive messages from inside or outside the 
College. Student email addresses are: username@students.pima.edu 
 
Employee email: Employees use Microsoft Outlook as their email/calendar system. 
WebOutlook is available from a channel on the Home tab as well as from the email icon.  
You may continue to use your desktop client or weboutlook.pima.edu to send and receive 
email. Employee email addresses are: username@pima.edu. 

Contextual Help 
Contextual help, or content sensitive help, provides information that is appropriate to the 
MyPima section you are in. Any time you need help, click on the help link, located on the 
upper-right hand side in the Utility icons. The help documentation is good, and can 
provide you with in-depth information about how the Course Homepage works. Use it 
frequently to become a power user! 

The Course Homepage 
The Course Homepage is an easy-to-
use tool for communicating to your 
students. The Course Homepage is not 
designed to replace the face-to-face 
classroom sessions, but it serves to 
supplement the classroom. 
 
With the Course Homepage, you can 
post course-related content on a secure 
network. It is not a full-scale course 
management tool like WebCT, for 
example it does not contain a tool for 
creating and managing tests online. 
 
The Course Homepage provides a set 
of easy-to-use tools for enhancing 
your classroom with online resources. With the Course Homepage, you can post course 
material online, including the syllabus, handouts and relevant links. You can also send 
out announcements and news to your class. Some suggested uses are 
 

• Place your syllabus online. 
• Place any relevant links you discussed in class online. 
• Place course lecture notes or sample tests online 
• Place durable links to library resources online. 
• Send out reminders for upcoming events, such as upcoming exams. 

 
The Course Homepage can be used with traditional courses, such as a 
 

• Face-to-Face classes. 

The primary differences between 
MyPima’s Course Homepage and WebCT 
are  
 

1. WebCT can create a complete 
system for online learning, leading 
students though a course by 
modules.  

2. The Course Homepage is not a 
complete learning environment, it is 
intended to supplement instruction 
and increase communication among 
class participants. 
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• Independent Study courses. 
• Self-Paced courses. 
• Weekend courses. 
• Web enhanced courses (no reduced seat time). 

 
The WebCT should be used for all courses that are: 
 

• Hybrid courses (reduced seat time). 
• Fully online courses. 

 

Getting to your Course Homepage 
To locate the Course Homepage, first click on the Teach/Advise tab, the click the link in 
the My Courses channel, as shown on the screenshot on the next page. 

 
 
This will take you to the My Courses page. On this page, you will see a list of courses 
you are attending and/or teaching. If necessary, you may need to use the “Course 
Schedule for:” drop-down box to select the proper term. Next to the list of courses, you 
will see additional information about the course, including the CRN and the course 
instructors. 
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Before the beginning of the semester, Course Homepages are automatically populated 
with faculty and students based on Banner data. No courses will be listed if you have not 
registered for or are not teaching a class. If your course is not listed, contact your campus 
Master Scheduler, department chair or division dean.  Master schedulers can also 
accommodate team teaching situations to allow all instructors access to the course area. 
 
To go to the each specific Course Homepage, click on the link to your course in the My 
Courses channel. 
 

 
 
 
On the Course Homepage, you will see four sections on the left-hand side: 
 

• Course Tools 
• Content Tools 
• Configuration Tools 
• Personal Tools 

 
The Course Tools provide links to various sections in your Course Homepage. The 
Course Tools are the only tools seen by the students. 
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The Content Tools are the tools you use to manage you homepage. These tools allow 
you to add content to your homepage. The students will not see the list of Content Tools. 
 
The Configuration Tools allows you to set-up, or configure, the Course Homepage. 
Using the Configuration Tool, you can set-up the Content Tools the students can use, 
manage students and instructors and set permissions. 
 
The Personal Tools allows you to view you profile and course and allows you to 
consolidate courses. 
 

 
 
Breadcrumbs identify your location in MyPima. You can use the links in the 
breadcrumbs to quickly go back to the previous page. 
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Exercise: 
1. Click on the Content/Layout Tools link. Using the instructions in the Manage 

Content/Layout page, do the following: 
a. Click on MyTab. 
b. Add a new Channel by clicking on the Add Channel button. 
c. Find a channel that is moveable, and move the channel to the right or left. 

When you are done, remove the new tab by following the onscreen 
instructions. 

 
2. Return to MyTab.  Click on the Teach/Advise tab.  Click on the link in the My 

Courses channel.  Go to your Course Homepage. 

Configuring the Course Homepage 
The Configuration Tools allow you to configure the Course Homepage, enabling the 
course tools you want to use, managing members and setting permissions. 

Applications 
You should only activate the Course Tools you will use in your class. The Course Tools 
you decide to make available to your class will display on the left-hand side of the Course 
Homepage.  
 
Deciding on what tools you want to use requires some planning on your part. You need to 
plan on how you will use the tool in your class. If you don’t need it, don’t enable it. You 
can turn it on at any point in the course.  The table below describes the various tools 
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available to you. The Homepage itself cannot be disabled, as you must always have a 
Course Homepage. 
 
Tool Description Students 

can Submit 
Items 

Homepage The default view of the Course Homepage, which 
displays the course information, news, 
announcements, message board topics, feature 
photos and links.  

No 

Announcements Allows you to compose and post announcements to 
the course members. 

No 

News Allows you to read articles posted by other course 
members and allows you to submit articles for 
possible posting.  

Yes 

Photos Allows you to view photos that have been posted and 
allows you to submit photos for possible posting. 

Yes 

Links Allows you to view the links that have been posted 
and submit links for possible posting. 

Yes 

Files Allows you to view the files which have been posted 
and submit files for possible posting. 

Yes 

Message Board Allows you to enter a message board where you can 
read and post topics, messages and replies. 

N/A 

Calendar Allows you access to a course calendar. N/A 
E-mail Allows you to send and receive email. N/A 
Chat Allows you to enter a chat room where you can 

participate in real-time discussions with other course 
members. 

N/A 

Members Allows you to view a list of other course members 
and information about each member, including any 
homepages a member may have. You may post you 
own homepage link. 

Students can 
only change 
the URL of 
their 
homepage. 

 
 
The last column, Students can Submit Items, identifies if a student can 
submit items for publication. While the student may submit items, it is 
up to you to activate, inactivate or delete the item. We will cover these 
steps in more detail later. 
 

 
To Configure the Course Tools 

1. Select Applications from the Configuration Tools menu. 
2. Check the Application you want enabled. 
3. Click on the Update button when finished. 
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Exercise: 
Configure the Course Tools, enabling and disabling the various applications and viewing 
how the tools appear/disappear under the Course Tools. Enable all applications when 
done for further exercises. 

Permissions 
The Permissions Listing sets who can edit, publish or share files and messages on the 
Course Page. The course instructor will automatically be added as the Course Leader. By 
default, the students are added as Current Members.  
 
By clicking on the red EDIT button, you may delegate permissions for the various 
applications. Do not give students in your class permission to manage these 
applications. You are responsible for managing the Course Homepage, as it’s your 
classroom.  
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Chat and Email Tools 

The Chat Tool 
The Chat tool is a text-
messaging application. 
With this application, any 
class member can chat 
with other users who are 
online. Each course has 
its own chat room, and if 
enabled, is always on. 
You, as the instructor, do 
not have to be present 
when students are using 
the chat tool.  
 
When you enter a chat 
room, you will see a list 
of users who are online. 
You can chat with 
everyone who is online 
by typing in a message 
and hitting the return key. 
This sends your message 
out to everyone who is in the chat room. 

If you want to send a private message, use the Whisper button.  
 
This application must be enabled before you can use it. How to enable applications is 
covered in the “Configuring the Homepage” section. 
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The E-mail tool 
The e-tool in the Course Homepage allows you to send e-mail to the people who are 
enrolled in the course.  
 

 
 
To send an e-mail 
 

1. Click on the E-mail tool located under Course Tools. 
2. Select the members you want to send the e-mail to. 
3. Click on the Send E-mail tool. 
4. Compose your message. 

a. Add an attachment by clicking on the Attach button. 
b. Spell check your message by clicking on the Spell Check button. 

5. Students can: Save a Copy to Sent Folder, Save a Draft, Send or Cancel.  Faculty 
can Send or Cancel the email. 

 
When you send an e-mail, the message will be sent to the members you selected, but the 
names of the members will not be seen in the Compose e-mail window. These messages 
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will be sent as a Bcc. (Blind Carbon Copy: where each member gets the same message 
but cannot see who else the message was addressed to.) 
 
E-mail cannot be seen inside the Course Homepage. To view e-mail, students need to go 
back to the MyPima Home tab or click on the e-mail icon at the top of the MyPima web 
page. Since e-mail is not course specific, but global, any course-related e-mail should 
clearly identify the course in the subject line. If not, it may easily get lost between 
regular email and other courses’ email messages. Faculty email will be delivered to their 
Outlook account.   
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Adding Content to the Course Homepage 
Once you have access to your Course Homepage and have enabled the appropriate 
applications, your next task is to add content. Without content, the Homepage will be just 
a shell with basic course and instructor information.  
 
Remember you must keep the content current. You cannot just “File-and-Forget,” or post 
information at the beginning of the semester and never update the content. The same goes 
with email. If you are going to use the email tool, then you need to check the email on a 
regular basis. Your course syllabus should include how you are going to use the Course 
Page in the classroom, and should set expectations, such as how many times you will 
check your email and policies on what will be shared and/or posted and how the posts 
will be moderated. 
 

The contents of the Course Homepage does not have to be recreated every 
semester, and contents between similar courses can be shared by using the 
Consolidated Courses feature.   This is covered in a later.   
 
Course Content is not archived.  
 
Each student, staff and faculty member has a pima.edu account, which will serve as the 
email account during one’s tenure at the College. Emails within the Course Homepage 
are archived by the individual within their email system (Outlook for employees, SunOne 
for students).  These email accounts are full-featured, personal email accounts that accept 
internal and external email and are not limited to course email. (This is different from 
WebCT where email is restricted to the WebCT environment.)  
 
It is your responsibility 
 

• To have an antivirus software installed and scanning all files that you upload or 
download to your computer. MyPima also scans all files uploaded to courses for 
viruses. 

• To back up all important course files on a separate location, such as a DVD. 
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Manage Homepage 
The Manage Homepage Content Tool allows you to create and update three sections: 
 

• Feature Photo 
• Featured Link and 
• Top 5 Links. 

 
These three sections are shown on the Course Homepage. 
 

 
 
. After you have uploaded images and have created links, you can use the Edit function to 
add/edit the Featured Photo, Featured Link and Top 5 Links. 
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Setting the Featured Photo 

1. Click on the Featured Photo Edit button. 
2. Select the photo you want featured or inactive the section if you want no photo 
3. Click on the Set Photo button to activate your selection. 

 
Setting the Featured Link 

1. Click on the Featured Link Edit button. 
2. Select the link you want featured or inactive the section if you want no links. 
3. Click on the Set Link button to activate your selection. 

 
Setting the Top 5 Links 

1. Click on the Top 5 Links Edit button. 
2. Select the links you want featured or inactive the section if you want no links. 
3. Click on the Top 5 Links button to activate your selection. 

 
Before you can select which photo or links to place on the Homepage, the photo and links 
must be imported (or loaded) into MyPima. Go to the Manage Photos or Manage Links to 
learn how to import photos or links. 
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Manage Course News 
The Course news should be used to post routine course announcements and information.  
You can input and activate course news articles and your students can submit content for 
your approval and activation. To activate/deactivate the News application, click on the 
Applications link, located under Configuration Tools. 
 
To post a news article, you must  

1. Click on the News link in the 
Course Tools section and  

2. Click on the Post an Article link. 
3. Select the Status, Title/Subject 

and select if the News Article will 
be in plain text or HTML. 

4. Write your message. 
5. Click on Post or Cancel when 

done. 
 
 
Students can submit a news article for your review using the following steps  

1. Click on News in the Course Tools section,  
2. Click on Submit an Article 
3. Enter a Title/Subject and select if the News Article will be in plain text or HTML 
4. Enter the news article 
5. Click Submit 

 
You must review articles that students have submitted through Manage News before they 
are available to the class. You can:  

1. Select Manage News under Content Tools 
2. Activate or Delete the submitted article from the Manage News page or click on 

the article title to read and/or edit the article and then activate or delete it 
 
Advanced users may use HTML in the text of the news article, but there is no HTML 
editor available within the Course Homepage.  Only HTML may be used; no JavaScript 
or any other scripting language.  You cannot imbed images. The Course Homepage is 
sensitive to incorrect HTML.   
 
If you decide to activate/post any article, you may inactivate or delete it later. All 
inactivate articles are saved and you may re-activate or delete them at any point. Once an 
article is deleted, it is permanently gone and cannot be recovered. 
 
 

Exercise: 
1. Post a news article in Manage News, selecting the submitted status in the drop 

down menu.  

• Submitted: Items which have been 
submitted, but not yet reviewed and 
posted. 

• Active: Items which have been 
posted and are visible on the course 
homepage. 

• Inactive: Items which have been 
deactivated (not visible on the 
homepage) but not yet deleted. 



 20

Manage Photos 
If you have activated the Photos application, you may provide images for your students 
and your students may submit photos for your review and approval. To enable the 
application, click on the Applications link, located under Configuration Tools.  
 
Students do have the ability to submit photos. As the instructor, you must review and 
manage any submitted photos. 
 
Posting a photo is straight-forward: 

1. Click on Photos in Course Tools 
2. Click on Post a Photo 
3. Select Active 
4. Browse to find the photo you want to 

post 
5. Enter a brief title for the photo (displays 

on homepage) 
6. Select whether the caption will be in 

plain text or html 
7. Enter a caption 

 
Students can submit a photos for your review using the following steps  

1. Click on Photos in the Course Tools section,  
2. Click on Submit a Photo 
3. Follow steps 4-7 above 
4. Click Submit 

 
Managing photos is just like Managing News.  (previous page) 

Exercise: 
1. Post a new photo in Manage Photos, selecting the submitted status in the drop 

down menu.  
2. Go back to the Manage Photos section and change the status of the submitted 

photo to active. 
3. Post another photo, placing it in inactive status, then go back to the Manage 

Photos section, and change the status of both photos, making the active photo 
inactive and the vice versa. 

4. Go to the Manage Homepage section, and make the one of the photos active. 
Click on the Homepage link, under the Course Tools section, to see active picture. 

Photos: Size and type 
At the time of this printing, 
the maximum file size that 
can be submitted is 2MB. If 
possible, reduce any photos to 
a small file size.  
 
Photos should be GIF’s or 
JPG’s. 
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Manage Links 
If you have activated the Links 
application, you may provide links to 
web pages for your students and your 
students may submit links for your 
review and approval. To enable the 
application, click on the Applications 
link, located under Configuration Tools.  
 
Submitting an instructor link, or student 
link submission and instructor review 
are very similar to processes used in news and photos.  
 
Key differences are: 

• You must enter a URL for the link. For example: www.pima.edu for a link to the 
Pima home page 

• Always check your links! Web pages move or are deleted, so check that you still 
are providing live content to your students. 

 
Links can also be incorporated into Course News using HTML code, or can be included 
in Word documents posted to the Files section of My Courses. 

Exercise: 
• Post a new link in Manage Links, selecting the submitted status in the drop down 

menu.  
• Go back to the Manage Links, section and change the status of the submitted 

photo to active.  
• Post another photo, placing it in inactive status, then go back to the Manage 

Links, section, and change the status of both photos, making the active photo 
inactive and the vice versa. 

• Go to Manage Homepage, under Content Tools. Make the one of the links the 
Featured Link. Click on the Homepage link, under the Course Tools section, to 
see the featured link. 

 

• Submitted: Links which have been 
submitted, but not yet reviewed and 
posted. 

• Active: Links which have been 
posted and are visible on the course 
homepage. 

• Inactive: Links which have been 
deactivated (not visible on the 
homepage) but not yet deleted. 
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Manage Files 
If you have activated the Files application, you can make computer files (e.g., Word 
documents, PowerPoint presentations) available to your students and your students can 
submit files for your review and approval. To enable the Files application, click on the 
Applications link, located under Configuration Tools.  
 
Submitting a file as an instructor, or student file submission and instructor review are 
very similar to processes used in news and photos. Manage Files lets you post course 
content online. Using this tool, you can post text documents to the Course Homepage for 
the students to view. You can also add and delete folders and files with the Manage Files 
tool. 
 
Files may not be larger then 25 MB.  The Course Homepage is not an HTML editor, and 
shouldn’t be used to create stand-alone web pages or a course website.  
 
A student may submit a file for your review. The file is 
not automatically posted to the class web site. In the 
Manage Files section, you will see a “New file requests” 
link in the middle of the page if files have to be activated 
by you. Clicking on this link will lead you to a list of 
files. 
 
To active a submitted file,  

1. To check the file, click or right-click on the name of the file and run or open the 
file as appropriate to check the file.  

2. To post the file on the group or course homepage, click Activate.  
3. To reject the file from being posted, click Delete.  
4. To return to the previous page (Manage File page), click Done. 

 
To add a file,  

1. Go to the Manage Files section by Clicking on the Manage Files link under 
Content Tools. 

2. Under the Folders section, select the folder where you want to put the file. The 
folder selection is highlighted in yellow. (See the next paragraph if you want 
to add another folder.) 

3. Using the Browse button, find the location of the file you want to add. 
4. Click on the Add button. 

 
To add a folder 

1. Go to the Manage Files section by Clicking on the Manage Files link under 
Content Tools. 

2. Under the Folders section, select the folder where you want to put the file. The 
folder selection is highlighted in yellow, with the default being the top-level 
folder. 

3. Type in the name of the new folder in the Add New Sub-folder text box. 
4. Click Add when done. 

Files: Size and Type 
Any type of files may be 
posted. As of this 
printing, the maximum 
file size is 25 MB. 
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Editing a file allow you to rename or replace a file or change the folder where the file 
resides at. To edit a file, 

1. Go to the Manage Files section by Clicking on the Manage Files link under 
Content Tools. 

2. Select the folder where you want to put the file.  
3. Click on the red edit button. 
4. Change the file name, folder location or replace the file. 
5. Click Update or Cancel when done. 

 
To delete a file,  

1. Go to the Manage Files section by Clicking on the Manage Files link under 
Content Tools. 

2. Select the folder where the file resides at.  
3. Check the file you want to delete. 
4. Click on the Delete button. 

 
You can search for files by file name, folder name or file content. The file content search 
does not work on Word, Excel or other proprietary file formats. To search for a file, 
 

1. Go to the Files or Manage Files section by clicking on the Manage Files link 
under Course Tools or the Manage Files link under Content Tools. 

2. Check the appropriate search criteria of file name, folder name or file content. 
You may select a single criteria, a combination or all criteria. 

3. Type in the search terms in the that contain textbox. 
4. Click on the Search button. 

 

 
 
The search results will be returned to you. 
 

Exercise: 
• Add a new file to the Course Homepage using the Mange Files tool. 
• Add a sub-folder to the Mange Files page. 
• Edit the file you just added, changing the folder location to the sub-folder you just 

created. 
• Add another file. 
• Click on the Files link under the Course Tools section. Verify that the files you 

just added are there. Click on the files to make sure that the files open correctly. 
• Delete one of the files. 
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Manage Message Board 
If you have activated the Message Board application, your class can conduct 
asynchronous online discussions. To enable the application, click on the Applications 
link, located under Configuration Tools.  
 
The Message Board allows your class to have online discussion about a specific topic. 
The contents of the Message Board are open to everyone in the class, and should not be 
used for private communications between individuals.  
 
A message board is divided into topics, messages and replies. To start a conversation, 
you need to post a topic. The message board participants create a message by responding 
directly to a topic. A reply is made when they respond to a message.  
 
To get the message board started, you must post a topic. To post a topic,  
 

1. Click on the Message Board link under Course Tools or Content Tools. (It doesn’t 
matter which link.) 

2. Click on the Post a Topic link. 
3. Fill in the Title of the message and put the message into the Description textbox. 
4. Click Post or Cancel. 

 
You can read and post topics, messages and replies in both locations, clicking of the 
Message Board under Course Tools or by clicking on the Manage Message Board under 
Content Tools. However, you can only delete messages by opening the Manage Message 
Board section. Once a message is deleted, it is permanently gone. 
 
To manage the message board,  
 

1. Click on the Manage Message Board link under Content Tools. (It doesn’t matter 
which link.) 

2. Click on the red “d” to delete the topic. 
3. Expand the topic by clicking on the small triangle located next to the topic to 

view the messages. 
4. Click on the red “d” to delete the message. 
5. Click on the small triangle located next to the message to view the replies. 
6. Click on the red “d” to delete the replies. 

 
When you delete a message, clicking on the top level “d” deletes all the messages below 
it, as shown in the diagram below. 
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At any time, whether you are reading or managing the messages, you may go back to 
either the message list or topic list by clicking on the Topic List or Message List 
hyperlinks, located under the breadcrumbs at the top of the page. 
 

Exercise: 
• Post two new topics. 
• Post a message to another topic. 
• Reply to a message. 
• Delete one of your topics. 
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Manage Announcements 
Announcements are critical, short notices that you need the class to be aware of. For 
example, you may want to inform the class of a cancellation or relocation.  Managing the 
announcements gives you a way to create, edit and delete announcements. 
 
All announcements are shown on the MyPima Home tab in the Personal Announcements 
channel, so you must clearly identify the class in the subject header. If not, the 
announcement will appear out-of-context when it appears in the channel. Subject headers 
such as “ART 101: Exam postponed until 9/23” or “BUS 234: Class Cancelled” clearly 
identify the announcement contents. 
 
NOTE: Announcements should be used sparingly, since students will be in many classes 
and groups, and we will also be using Announcements to alert students to important 
academic or financial events.  
 

 
 
 
To send an announcement,  
 

1. Click on the Announcements link under Course Tools or use the Manage 
Announcements link under Content Tools. 
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2. Click on the Send Announcements link or New Announcements button, 
respectively. 

3. Type in the announcement information. 
4. Click on Send or Cancel. 

 
Take care to pay attention to the automatic message deletion time. Announcements will 
automatically delete in seven days, so do not post any announcements that take place in 
more then seven days. If you do, the announcement will expire before the event take 
place. The expiration date is on located on the Compose Announcement tool, as shown 
below. 
 

 
 
To edit an announcement,  
 

1. Click on the Manage Announcements link in the Content Tools section. 
2. Click directly on the announcement you want to edit. 
3. Edit the announcement. 
4. Click on Send or Cancel when done. 
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If you did make a change to the announcement, the announcement will be reset. 
 
To delete an announcement,  
 

1. Click on the Manage Announcements link in the Content Tools section. 
2. Check the announcement you want to delete. 
3. Click on the Delete button. 

 

Exercise: 
• Create a new announcement and send it out. 
• Click on the Announcements link under the Course Tools and verify your 

announcement was posted. 
• While still in the Course Tools, click on the Send Announcement link and send out 

another announcement. 
• Verify the announcement was posted. 
• Go back to the Manage Announcements page under the Content Tools. 
• Delete one of the announcements. 
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Manage Calendar 
Managing the calendar involves creating new events and tasks. On the manage calendar, 
there are four tabs: 
 

• View Tab: This folder contains information on working with events and tasks, 
including how to search and schedule tasks and events.  

• Calendar Tab: This folder contains information on creating calendars, editing 
existing calendars, and subscribing and unsubscribing to calendars.  

• Calendar Sets Tab: This folder describes calendar sets, including how to create 
and delete calendar sets, and how to edit an existing set by adding or removing 
calendars from the set.  

• Options Tab: This folder contains information on how to set the various Calendar 
application options, and also describes how to import data into a calendar, and 
export data from a calendar. 

 
As with all the content tools, the Calendar tool must be enabled before using it. 
 
The calendar tool is intended for student-related activities.  It will not synchronized with 
your Outlook calendar. For more in-depth information on using the Calendar tool, click 
on the help button when in the calendar view. 
 
The calendar icon on the MyPima home page provides a quick way to access the class 
calendar without having to open up your course homepage. 
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The Calendar View Tab 
The default tab of the Calendar is the View Tab. This tab lets you view your calendar, the 
associated events and tasks, and you can add new events and tasks. 
 

 
  
There are many options available to you in selecting different time periods and dates 
when viewing your calendar. 
 

• You may progress through the dates 
one at a time by clicking on the 
small yellow triangles, located next 
to the bolded date, above the event 
and task information. 

• To change the time period, click on 
the overview | day | week | month 
year | comparison links. 
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• To go to a specific date, enter the date in the spaced under the monthly calendar 
and press the arrow icon or click on the Jump To icon. 

 
 
 
 
 
 
 
 
 
 
 
 
To create events or tasks, use the New Event or New Task icons. The major difference 
between creating an event and task is an event involves other people. A task is set for 
something you need to do, and does not involve other people.  
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To create an event, click on the New Event tab. There are two essential items you must 
fill in when creating a task: The time and description of the event and who you want to 
invite. If you don’t know the full name of the persons you want to invite, use the Search 
button to find them. When you are done, click on the OK button, located at the bottom of 
the window. Click on this button will automatically add the event to the calendar and 
send out the invites.  
 

 
When you create an event, you may want to check if the persons you invite are available 
to attend. To check the availability of the event participates, you must first add the 
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invitees on the Compose tab, and then click on the Availability tab. To search for other 
availability dates, use the dates tool located in the Availability tab. 
 

 
 
A task is something you have to do. To create a new task, click on the New Task icon, 
located on the View tab in the calendar view. Within this tab, you can create task due 
dates and times, and indicate the status of the task. There is no Availability tab in the 
compose task window, since a task only involves you and you do not invite other people. 
Click OK or Cancel when done composing a task. 
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Common to creating both new events and tasks is the Reminders and Preview tabs. The 
Reminders tabs enables you to sent yourself a reminder about the event or task. The 
Preview tab lets you preview the event or task before it’s sent out. 
 
Every event and task you add to the calendar while in your course homepage is global. 
Make sure you clearly identify the event or task. 
 
To more icons we didn’t cover: Printable and Search. The Printable icon makes the 
calendar printer friendly. The Search icon lets you search events and tasks. 
 
When you are done with the calendar, click on the Exit icon, located in the upper right-
hand corner. 

The Calendars Tab 
The Calendars tab lists the calendars you are subscribed to. Use this tab to view, edit or 
remove calendars from your view. 
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The Calendar Sets 
The Calendar Sets tab allows you to view multiple calendars at once. You can add or 
remove calendars using this tab. 
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The Options Tab 
The Options tab lets you modify the behavior of your calendar. Some options you can set 
are:  

• The way dates are displayed (month, day, year; year, month, day; etc.) 
• Time (12 or 24 hour clock). 
• Day (day start, end, etc) 
• First day of the week (Sunday, Monday, etc). 
• Time zone. 
• Event and Task reminders. 
• Event Notifications. 

 
Click on the Save Changes button when finished. 
 

 
 

Exercise: 
Go into the calendar tool and create a new task and event. 
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Personal Tools 
The Personal Tools allows you to view you profile and courses, and allows you to 
consolidate courses. 

My Profile 
The information contained in the Member Information section is 

• Name: The name of the member. 
• Member type: Instructor or student. 
• Member Since: The date the member joined or was added to the group. 
• Last Visit: The date of the last time the member visited the Course Homepage. 
• Homepage: [not available within MyPima] 
• Permissions: The permission level of the member. 

My Courses 
My Courses list all the courses you are attending and/or teaching. 

My Consolidated Courses 
The Consolidated Courses tool is useful:  

• if you are teaching more than one section of a course and want to post 
content only once 

• if you want to move course content from one semester to another  
 
With this tool, you can post files, links or news to a consolidated “parent” course page 
and have it distributed to the “child” homepages all at once, without having to go to each 
course separately. Also, individual course content cannot migrate from semester to 
semester; only Consolidated Course content can migrate.   
 
You cannot “consolidate” at the end of the semester without double-posting files, news 
etc. to your active “child” courses. This must be accomplished at the beginning of the 
semester.  
 

Scenario 1:  Faculty member Juarez is teaching 3 Writing 101 sections and plans 
to provide lecture notes and samples for each module of the course.  MyPima has 
created 3 Course Homepages, 1 for each section. 
 
Plan of action:  Create a Consolidated Course “Juarez Writing 101” and place the 
files in this course.  All 3 sections will be associated with this consolidated 
course.  Juarez will be able to load the files into the consolidated course, and they 
will be displayed to students in each of the sections. 
 
Scenario 2:  Faculty member Greenley is teaching 1 section of AJS 101 in Spring 
2007, but he teaches it every semester.  He plans to load his PowerPoint 
presentations, and links to important web sites for his students.  Greenley would 
like these files to be available every semester. 
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Plan of action:  Greenley would create a Consolidated Course “Greenley AJS 
101” at the beginning of Spring semester.  When Summer Session A is available 
to faculty, he will associate his AJS 101 section in the summer with the 
Consolidate Course.  The Spring semester courses will eventually be disabled, but 
the consolidated course will remain. 
 

The My Consolidated Courses page lists the courses that are available for consolidation 
and those courses you have consolidated.  

Adding/deleting courses from an existing Consolidated Course 
To add or delete a section from a consolidated course that already exists: 
 

1. Go to the MyPima My Courses page.  This should the list of your courses. 
2. Click My Consolidated Courses near the top-right of the screen.  (see image 

page 8) 
3. Click the name of the consolidated course that you would like to add/remove 

sections from 
4. In the left column, under Configuration Tools, click Courses 
5. Take one of the following options: 

a. to remove a section, check the box next to its name under Active Courses, 
then click the Remove button 

b. to add a section, check the box next to its name under Available Courses for 
Consolidation, then click the Add button 

Deleting a Consolidated Course   
First you must remove the child courses that are associated with the course (see above).  
Then,  go to My Consolidated Courses and click in the check box next to the course title.  
Click Remove to remove the consolidated course. 

Featured Links Images in Consolidated/Child course displays 
If you add links or images to a consolidated course, the images or links are available in 
all the child courses through the “Links” and “Photo” navigation links.   
 
However, Featuring an image and/or links on the consolidated course homepage does not 
create a Featured homepage image or Featured homepage links in the child courses.  For 
each image/link you would like to Feature on the child home page you need to:  
 

1. add the image to each child course through Manage Photo 
2. add the links to each child course through Manage Links 
3. then Feature the image and links on the child course homepage through Manage 

Homepage 
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Log out of MyPima 
Be sure to logout when you are 
finished with MyPima. To log out,  
click on the key shaped logout icon, located in the upper right-hand corner of the screen.  
 

When you login to MyPima, the session is always open unless you logout. If you 
open another browser window up, say by clicking on a link within your course page, you 
are still logged into MyPima. If no activity happens on your account, you will be 
automatically logged out after 20 minutes. 
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Using the Course Homepage in your Course. 
You must carefully decide on how you will use the Course Tools in your course. Your 
syllabus should clearly state how you will use the Course Homepage. If you will not be 
using any tools at all, disable all applications. 
 
Remember, MyPima will automatically add a link to a Course Homepage for all non-
WebCT courses, with all students being automatically added as members. We 
recommend that, as a minimum, you should post your syllabus in the Course Homepage 
and enable/disable tools you will not be using. 
  
Consideration should be given to how you will use the announcements, news, calendar 
and email in class. You should be clear to students how often they should check theses 
sections and what happens when material is submitted for posting. For email, tell your 
students how often you will be checking email and how long it will take to respond back 
to their messages. If you will not be using email, then say so.  
 
There are two areas of consideration for using the Course Homepage tools in your class: 
procedural and pedagogical.  
 
Procedural issues concern how you will use these tools in the classroom and your 
expectations. Some questions to consider are 
 

• How often will I be checking the Course Homepage for student submissions?  
• Will I be sending out news and announcements? How often do I expect the 

student to check the Course Homepage? 
• Since eMail and Announcement can be seen on the Home tab or the students 

email InBox, are these messages easily identifiable, i.e. the class name put in the 
subject header? If there isn’t a standard way to address these messages, you may 
have a hard time determining which message/announcement is from which class. 

 
Pedagogical considerations are concerned with how you will integrate the Course 
Homepage tools in your teaching. Some questions to consider are: 
 

• Will the Course Homepage only serve as a file repository? 
• Would the message board serve as extension of the classroom lecture? 
• Will the students be required to participate in the message board and submit news 

articles? If so, are the grading requirements clear? Is there a rubric for grading? 
• Will I only publish items to the Course Homepage that were mentioned in class? 

Or will I post items outside of class and expect the students to read them prior to 
class? 
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Summary of the Announcements, Course News, Message Board and eMail Tools 
 
Tool What is it? Use Notes Student 

Submissions 
Allowed? 

Seen on 
the Home 
tab? 

Announcements Allows you to view, 
send and delete 
announcements. 

Announcements are short 
notices of upcoming events 
that that you want the class 
to be aware of. For 
example, you may want to 
send reminders about an 
upcoming exam or an art 
show.  

Announcements expire after a 
set time. 
 
Students cannot send or 
submit announcements, only 
facility members. 
 
Announcements are about 
major events only. 

No Yes 

Message Board An online public 
forum. 

Discuss a specific topic 
online. 

If you are going to use a 
message board in your class, 
the messages can be graded or 
un-graded. If graded, you 
must develop a rubric to set 
clear expectations for the 
student. 

N/A No 

Course News Allows you to post 
news articles 
relevant to the 
classroom goals.  

A news article might be 
anything from a 
informational 
announcement or it might 
be a article on a subject of 
interest to the group. 

Students can submit a news 
article, which must be 
reviewed and made active by 
the group leader. 

Yes No 

eMail Communication 
between students and 
instructor. Group or 
private (individual) 
messages can be 
sent. 

Can be used to discuss 
grades or other private 
instructor / student 
communications. 

Course leaders and students 
can send / receive email. 

N/A Yes 

 
 


